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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

Welcome to the HP LoadRunner Installation Guide. HP LoadRunner, a tool for 
performance testing, stresses your entire application to isolate and identify 
potential client, network, and server bottlenecks.

This guide describes how to install and set up HP LoadRunner.

This chapter includes:

➤ How This Guide Is Organized on page 8

➤ Who Should Read This Guide on page 8

➤ Documentation Library Guides on page 8

➤ Additional Online Resources on page 10

➤ Terminology on page 11
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How This Guide Is Organized

This guide contains the following chapters:

Chapter 1 Before You Install

Provides you with the information that will help you prepare for the 
LoadRunner installation process, including system requirements.

Chapter 2 Installing LoadRunner on Windows

Describes how to install either the full version of LoadRunner on a Windows 
machine.

Chapter 3 Installing the HP Load Generator on Linux

Describes how to install and configure the load generator on a Linux 
platform.

Chapter 4 Viewing and Modifying a License

Describes how to enter, modify, or view LoadRunner license information.

Who Should Read This Guide

This guide is intended for users who need to install and set up LoadRunner.

Readers of this guide should have some knowledge of system 
administration.

Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

Using this Documentation Library explains how to use the Documentation 
Library and how it is organized.

http://www.adobe.com
http://www.adobe.com
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Accessing the Documentation

You can access the documentation as follows:

➤ After installing LoadRunner, click Start > All Programs > HP Software > 
HP LoadRunner > Documentation and select the relevant document.

➤ From the Controller Help menu, click Documentation Library to open the 
merged help.

Getting Started Documentation

➤ Readme. Provides last-minute news and information about LoadRunner. 
You access the Readme from the Start menu.

➤ HP LoadRunner Tutorial. Self-paced printable guide, designed to lead you 
through the process of load testing and familiarize you with the 
LoadRunner testing environment. To access the tutorial, click Start > All 
Programs > HP Software > HP LoadRunner > Documentation > Tutorial.

LoadRunner Guides

➤ HP Virtual User Generator User Guide. Describes how to create scripts 
using VuGen. When necessary, supplement this user guide with the 
online HP LoadRunner Function Reference. 

➤ HP LoadRunner Controller User Guide. Describes how to create and run 
LoadRunner scenarios using the LoadRunner Controller in a Windows 
environment. Also describes how to set up the server monitor 
environment and configure LoadRunner monitors for monitoring data 
generated during a scenario run.

➤ HP LoadRunner Analysis User Guide. Describes how to use the 
LoadRunner Analysis graphs and reports to analyze system performance 
after running a scenario.

➤ HP LoadRunner Installation Guide. Explains how to install LoadRunner 
and additional LoadRunner components.
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LoadRunner References

➤ LoadRunner Function Reference. Gives you online access to all of 
LoadRunner’s functions that you can use when creating Vuser scripts, 
including examples of how to use the functions.

➤ Analysis API Reference. This Analysis API set can be used for unattended 
creating of an Analysis session or for custom extraction of data from the 
results of a test run under the Controller. You can access this reference 
from the Analysis Help menu.

➤ Troubleshooting. The Output dialog box (Controller > View > Show 
Output) displays details of any errors encountered during a scenario run. 
Click the icon in the Help column to open the Troubleshooting guide. 
This guide provides clear explanations and troubleshooting tips for many 
Controller connectivity and Web protocol errors. It also provides general 
troubleshooting tips for Winsock, SAPGUI, and Citrix protocols.

Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The 
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support Site. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
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To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Terminology

Documentation Updates

HP Software is continually updating its product documentation with new 
information.

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to the HP Software Product Manuals Web site 
(http://h20230.www2.hp.com/selfsolve/manuals).

Vuser A virtual user—a LoadRunner-created user that 
emulates a human user.

Load Generator machine The workstation used to host the LoadRunner 
Vusers.

Controller machine The machine used to host the LoadRunner 
Controller.

Vuser Group A collection of Vusers with common characteristics, 
such as the machine on which they run, or the 
client that they use. 

http://h20230.www2.hp.com/selfsolve/manuals
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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1
Before You Install

This chapter provides you with the information that will help you prepare 
for the LoadRunner installation process. Before you install LoadRunner, 
please review the system requirements.

This chapter includes:

➤ Introducing the LoadRunner Windows Installation on page 13

➤ Introducing the LoadRunner Linux Installation on page 14

➤ Windows System Requirements on page 14

➤ Prerequisite Software on page 17

➤ Pre-installation Configuration on page 18

Introducing the LoadRunner Windows Installation

Your LoadRunner installation disk includes a setup program that guides you 
through the process of installing LoadRunner’s components. The setup 
program installs LoadRunner on the hard disk of a single-user computer. 

The LoadRunner installation installs a full LoadRunner configuration, 
including virtual user and server side components. 

For information about installing LoadRunner on a Windows machine, see 
Chapter 2, "Installing LoadRunner on Windows."
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Introducing the LoadRunner Linux Installation

You can install the LoadRunner Load Generator component on a Linux 
platform to run virtual users. The Linux virtual users interact with the 
LoadRunner Controller, installed on a Windows machine.

For more information, see Chapter 3, "Installing the HP Load Generator on 
Linux."

Windows System Requirements

This section describes the system requirements necessary for installing the 
LoadRunner components on a Windows machine.

Note: For HP Diagnostics system requirements, refer to the HP Diagnostics 
Installation and Configuration Guide. 
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Controller, VuGen, and Analysis System Requirements
The following table describes the system requirements for installing the 
Controller, VuGen, or Analysis.

Processor

CPU Type: Intel Core, Pentium, Xeon, AMD or 
compatible

Speed: 1 GHz minimum. 2 GHz or higher 
recommended

Operating System

➤ Windows XP Professional SP3 32-bit

➤ Windows Server 2003 Standard 
Edition/Enterprise Edition SP2 32-bit

➤ Windows Server 2008 Standard 
Edition/Enterprise Edition SP2 32-bit and 64-bit

➤ Windows 7 SP1 32-bit and 64-bit

➤ Windows 2008 R2 SP1

Memory (RAM)
Minimum: 2 GB
Recommended: 4 GB or higher

Screen Resolution Minimum: 1024 x 768

Browser

➤ Microsoft Internet Explorer 6.0 SP1 or SP2

➤ Microsoft Internet Explorer 7.0

➤ Microsoft Internet Explorer 8.0

➤ Microsoft Internet Explorer 9.0

Available Hard Disk Space Minimum: 4 GB
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Load Generator for Windows System Requirements
The following table describes the system requirements for installing the 
Load Generator on a Windows machine.

Note: For information about system requirements for installing the Load 
Generator on Linux machines, see "Linux System Requirements" on page 47.

Processor

CPU Type: Intel Core, Pentium, Xeon, AMD or 
compatible

Speed: 1 GHz minimum. 2 GHz or higher 
recommended

Operating System

The following Windows operating systems are 
supported:

➤ Windows XP Professional SP3 32-Bit

➤ Windows Server 2003 Standard 
Edition/Enterprise Edition SP2 32-Bit

➤ Windows Server 2008 Standard 
Edition/Enterprise Edition SP2 32-Bit and 64-bit

➤ Windows 7 SP1 32-bit and 64-bit

➤ Windows 2008 R2 SP1 

Memory (RAM)

Minimum: 1 GB 

Note: Memory depends on protocol type and 
system under test and can vary greatly.

Browser

➤ Microsoft Internet Explorer 6.0 SP1 or SP2

➤ Microsoft Internet Explorer 7.0

➤ Microsoft Internet Explorer 8.0

➤ Microsoft Internet Explorer 9.0

Available Hard Disk Space Minimum: 2 GB 
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Prerequisite Software

Specific software needs to be installed before you can install LoadRunner. 
When you run the LoadRunner installation wizard, if the prerequisite 
software is not already installed on your computer, the wizard detects which 
software is missing and provides the option to install it. 

The following prerequisite software needs to be installed:

➤ Microsoft Windows Installer 3.1

➤ Windows Imaging Component. This is a prerequisite for .NET Framework 
4.0.

➤ .NET Framework 3.5 SP1 (See the note below for installation instructions.)

➤ .NET Framework 4.0

➤ Web Services Enhancements (WSE) 2.0 SP3 for Microsoft .NET 
Redistributable Runtime MSI

➤ Web Services Enhancements (WSE) 3.0 for Microsoft .NET Redistributable 
Runtime MSI

➤ Microsoft Core XML Services (MSXML) 6.0

➤ Microsoft Visual C++ 2005 SP1 Redistributable Package MFC Security 
Update (x86)

➤ Microsoft Visual C++ 2005 SP1 Redistributable Package MFC Security 
Update (x64)

➤ Microsoft Visual C++ 2008 SP1 Redistributable Package MFC Security 
Update (x86)

➤ Microsoft Visual C++ 2008 SP1 Redistributable Package MFC Security 
Update (x64)

➤ Microsoft Visual C++ 2010 SP1 Redistributable Package MFC Security 
Update (x86)

➤ Microsoft Data Access Components (MDAC) 2.8 SP1 (or later)
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Note: 

➤ Windows 7: .NET 3.5.1 is installed by default.

➤ Windows 2008 R2: To install .NET 3.5.1, click Administrative Tools > 
Service Manager > Features. Click Add Features, select the .NET 
Framework 3.5.1 check box, and then click Install.

➤ All other supported version of Windows: Install .NET 3.5.1 using the 
.NET 3.5.1 installer.

Pre-installation Configuration

Before you begin the installation, review the following configuration 
information:

➤ To run the LoadRunner installation, you must have full local 
administrative rights on the designated machine.

➤ If any version of LoadRunner is installed on your machine, uninstall the 
current version before you begin the new installation.

➤ You cannot use the UNC (Universal Naming Convention) path to run the 
installation. Therefore, if the LoadRunner installation folder is located on 
a network drive, the network drive needs to be mapped before you can 
run the installation.

➤ LoadRunner does not support installation via terminal service. 
Installation must be performed at the destination machine.

➤ You cannot install LoadRunner on a machine that contains an existing 
installation of HP Performance Center or a standalone installation of 
either Analysis, VuGen, or Service Test.

➤ If you are working with a non-English version of Windows, and your 
machine does not have an internet connection, .NET Framework 3.5 SP1 
must be installed before you run the LoadRunner installation.
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2
Installing LoadRunner on Windows

This chapter describes how to install the full version of LoadRunner on a 
Windows machine. 

This chapter includes:

➤ Performing the Installation on page 20

➤ Installing Additional Components on page 32

➤ Configuring User Login Settings on page 40

➤ Silent Installation of LoadRunner on page 42

➤ HP LoadRunner User Interface Pack Installation on page 43

➤ Upgrading LoadRunner on page 44
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Performing the Installation

Caution: Before you install LoadRunner, review the pre-installation 
information, including the system requirements, described in Chapter 1, 
"Before You Install." 

To install LoadRunner or an additional component:

 1 Run the setup.exe file in the root folder of the installation disk. 

The LoadRunner installation program begins and displays the installation 
menu page. 

 2 Select the required installation option.

From the installation menu page, select one of the following options: 
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➤ LoadRunner Full Setup. Installs the main LoadRunner components, 
including the Controller, the Virtual User Generator (VuGen), 
Analysis, and the Load Generator. Use this option for the machine that 
runs the load testing scenarios.

For details on the components that are included in the installation, see 
"LoadRunner Installation Components" on page 30.

➤ VuGen. Installs a standalone version of the LoadRunner Virtual User 
Generator, VuGen.

➤ Analysis. Installs a standalone version of LoadRunner Analysis.

➤ Load Generator. Installs the components needed for running virtual 
users to generate load. Use this option for machines that are used to 
generate load only, and not to control Vusers.

➤ Monitors Over Firewall. Installs the components on the agent machine 
for monitoring over the firewall. For more information, refer to the 
“Using Firewalls” chapter in the HP LoadRunner Controller User Guide.

➤ MI Listener. Installs the components needed on the MI Listener 
machine used in running Vusers over a firewall and monitoring over a 
firewall. For more information, refer to the “Using Firewalls” chapter 
in the HP LoadRunner Controller User Guide.

➤ Host ID. Opens the Host ID Generator that displays the computer’s 
Host ID.

➤ Additional Components. Opens the Additional Components folder 
located in the root folder of the LoadRunner installation disk. From 
this folder, you can install the following components:

➤ Agent for Citrix Server

➤ Agent for Microsoft Terminal Server

➤ Assembly Crawler for Analysis API

➤ HostID Generator

➤ HP Diagnostics Mediator

➤ HP Performance Validation SDK

➤ IDE Add-Ins

➤ LRTCPDump
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➤ Monitor Probe for Microsoft COM+ Server Components

➤ MQTester

➤ SAP Tools: SAPGUI Spy, SAPGUI Verify Scripting, Verify RFC User

➤ Standalone Applications: Analysis, Load Generator, MI Listener, 
Monitors over Firewall, VTS (Virtual Table Server), and VuGen

➤ WinPcap

For a description of each of these components, see "Installing 
Additional Components" on page 32.

 3 If necessary, install prerequisite software.

Specific software, for example, .NET Framework 3.5 SP1, needs to be 
installed before you can install LoadRunner. If the prerequisite software is 
not already installed on your computer, a dialog box opens displaying the 
list of prerequisite programs that are required. 
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Click OK to install the listed software before continuing with the 
LoadRunner installation. If you click Cancel, the LoadRunner installer 
exits because LoadRunner cannot be installed without the prerequisite 
software.

Note: For the full list of prerequisite software, see "Prerequisite Software" 
on page 17.

 4 Start the LoadRunner installation.

The LoadRunner Setup Wizard opens, displaying the welcome page.

Click Next to proceed.
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 5 Review the License agreement.

If the terms of the license agreement are acceptable to you, select I Agree. 

Click Next to proceed.
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 6 Register the LoadRunner Installation on your computer.

In the Customer Information page, enter your name and organization 
name. 

Click Next to proceed.
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 7 Select an Installation folder.

Accept the proposed folder for the installation or browse to an alternate 
folder.

Click Disk Cost to check the disk space for each drive. The dialog box 
displays the size, available space, and required space for each disk.

Click OK to close the Disk Cost dialog box. 

Click Next to proceed.
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 8 Start the installation process.

The wizard prompts you to confirm the installation.

Click Next to start the installation. The Installing HP LoadRunner screen 
opens indicating the progress of the installation.
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 9 Complete the installation process.

When the installation is complete, a wizard page opens, confirming 
successful installation.

Click Finish to close the LoadRunner installation program. 
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 10 Check your license information.

The LoadRunner installation is now complete. The LoadRunner License 
Utility opens, displaying your LoadRunner license information. 

During the LoadRunner installation, if LoadRunner does not detect a 
valid license on your computer, you are automatically granted a 
temporary 10-day license for 25 Vusers. To use LoadRunner beyond the 
10-day period, you must request and enter license information for your 
copy of LoadRunner. For more information, see "Viewing and Modifying 
a License" on page 63.
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Click Close to close the LoadRunner License Utility.

Notes:

➤ To uninstall LoadRunner, use the Windows Add/Remove Programs 
utility. Alternatively, you can run the setup.exe file located in the root 
directory of the LoadRunner installation disk, select LoadRunner Full 
Setup, and then select the Remove option in the Setup Wizard.

➤ To repair LoadRunner, run the setup.exe file located in the root directory 
of the LoadRunner installation disk, select LoadRunner Full Setup, and 
then select the Repair option in the Setup Wizard.

➤ If your version of LoadRunner is supplied with a plug and you have not 
already installed the plug, do so now by inserting it in the parallel port.

➤ You can configure LoadRunner to run Vusers on a Load Generator 
machine without the need for the user to manually log in to the 
machine. For more information, see "Configuring User Login Settings" on 
page 40.

LoadRunner Installation Components
The LoadRunner full setup installation includes the following components:

➤ Controller. Controls the execution of scenarios and Vusers. Includes the 
online monitors which monitor and display information about the test 
execution. Install the Controller only on the machine that will control 
the Vusers.

➤ Analysis. Graphs and reports for analyzing the load test.
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➤ ERP and CRM Mediator. The component needed to gather and correlate 
offline transaction data for the ERP/CRM diagnostics modules. For more 
information, refer to the ERP/CRM Diagnostics section in the HP 
LoadRunner Controller User Guide.

Note: The Mediator must be installed on a machine that resides in the 
same LAN as the monitored ERP/CRM server, preferably on a dedicated 
machine. It is not recommended to install the Mediator on a Siebel or 
Oracle server that is involved in the load test.

By default, the Mediator agent is installed to run as a process. It is 
recommended to configure the Mediator agent to run as a service. To 
configure the agent to run as a service, see Appendix , "Configuring User 
Login Settings"

➤ Load Generator. The components for running virtual users (including 
Windows-based GUI Vusers) to generate load. Note that to run GUI Vusers 
you must have one of HP’s functional testing products - QuickTest 
Professional or WinRunner - installed.

➤ MI Listener Component. Components for the MI Listener machine used 
in running Vusers and monitoring over the firewall. For more 
information, refer to the Using Firewalls chapter of the HP LoadRunner 
Controller User Guide.

➤ Monitors over FireWall. Components on the agent machine for 
monitoring over the firewall. For more information, refer to the Using 
Firewalls chapter of the HP LoadRunner Controller User Guide.

➤ Online Documentation. All LoadRunner user guides in PDF format.

➤ Protocol SDK. Enables LoadRunner to work with the HP Performance 
Validation SDK. To install this feature, you also need to install either the 
Vuser Generator or Load Generator. 

You install the HP Performance Validation SDK from the Additional 
Components folder located in the root folder of the installation disk. 
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➤ Samples. The LoadRunner sample flight application and Web server.

➤ Vuser Generator [VuGen]. LoadRunner’s tool for creating virtual user 
(Vuser) scripts, through recording. Vuser scripts emulate users without a 
graphical user interface by using direct function calls.

Installing Additional Components

You can install additional components that provide advanced features for 
working with LoadRunner. You install these components from the 
Additional Components folder, located in the root folder of the LoadRunner 
installation disk. The following components are available:

➤ Agent for Citrix Server. Installs an optional utility on the server machine 
which enhances VuGen’s capabilities in identifying Citrix client objects. 
For installation instructions, see "Installing the Citrix Server Agent" on 
page 35.

➤ Agent for Microsoft Terminal Server. Installs an optional utility on the 
RDP server. It provides enhancements to the normal RDP functionality in 
VuGen. For installation instructions, see "Installing the Microsoft 
Terminal Server Agent" on page 36.

➤ Assembly Crawler for Analysis API. Installs a command-line utility to 
build a .NET configuration file for a LoadRunner Analysis API application. 
For more information, refer to the Analysis API Reference.

➤ HostID Generator. Opens the Host ID Generator that displays the 
computer’s Host ID. For details, see "Determining the Host ID" on 
page 34.

➤ HP Diagnostics Mediator. Installs the HP Diagnostics Mediator, the 
component that gathers and correlates offline transaction data for the 
ERP/CRM diagnostics modules. For more information, refer to the 
ERP/CRM Diagnostics section in the HP LoadRunner Controller User Guide.

➤ HP Performance Validation SDK. Provides you with the tools to create a 
custom protocol to run load tests on a previously unsupported 
application. For more information, refer to the HP Performance Validation 
SDK Developer’s Guide.
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➤ IDE Add-ins. Installs a component that enables you to create and run 
scripts, written in your standard development environment, in the 
application's native language. Select an add-in from the IDE Add-ins 
directory, and run the add-in’s executable file.

➤ LRTCPDump. Gives you access to VuGen’s command line utilities for 
creating trace files containing logs of TCP traffic over the network. For 
more information, refer to the HP Virtual User Generator User Guide.

➤ License Server for Service Test. Installs the Sentinel License Manager for 
use with HP Service Test. For more information, see the section about 
installing a Service Test license server in the Service Test Installation Guide, 
hpst_install.pdf, located in the product’s help folder.

➤ Microsoft COM+ Server Monitor Probe. Configures the server machine 
for COM+ monitoring. For more information on configuring the server, 
refer to the Application Component section in the LoadRunner Monitor 
Reference.

➤ MQTester. Installs MetaStorm’s MQTester for HP LoadRunner. It allows 
you to test IBM’s WebSphere MQ-based systems in a LoadRunner 
environment.

➤ SAP Tools

➤ SAPGUI Spy. Helps examine the hierarchy of GUI Scripting objects, on 
open windows of SAPGUI Client for Windows. To install the SAPGUI 
Spy component, copy the three files mscomctl.ocx, Msflxgrd.ocx and 
msvbvm60.dll from the SAP_Tools\SapGuiSpy\System32VBdlls 
directory to your C:\WINNT\system32 directory and then register the 
files. To register each file, select Run from the Windows Start menu and 
type: regsvr32 <File name>. Run the SapSpy.exe file from the 
SAP_Tools\SapGuiSpy directory.

➤ SAPGUI Verify Scripting. Helps you verify that the SAPGUI Scripting 
API is enabled. To install the Verify Scripting component, run the 
VerifyScripting.exe file from the SAP_Tools\VerifySAPGUI directory.
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➤ Verify RFC User. Determines whether the SAP user you have specified 
to connect to the SAP system, has permissions to invoke the required 
RFC functions necessary for working with SAP Diagnostics. To install 
the Verify RFC User component, copy the file 
RFCFunctionsCollection.dll from the SAP_Tools\VerifyRFCUser 
directory to your hard drive and then register the file by selecting Run 
from the Windows Start menu and typing: regsvr32 
RFCFunctionsCollection.dll. In the SAP_Tools\
VerifyRFCUser directory, load the AddMTSDestinationsFolder.reg by 
double-clicking the file and then run the VerifyRFCUser.exe file.

➤ Service Test Add-in. Enables you to run VuGen with all of the HP Service 
Test capabilities. This integration requires an HP Service Test license. For 
more information, see the section about installing HP Service Test in the 
Service Test Installation Guide, hpst_install.pdf, located in the product’s 
help folder.

➤ Standalone Applications. Enables you to run standalone installations of 
the following applications: Analysis, Load Generator, MI Listener, 
Monitors Over Firewall, VTS (Virtual Table Server), and Virtual User 
Generator (VuGen). Run the relevant application’s setup program from 
the Additional Components\Standalone Applications folder, and follow 
the wizard’s instructions to completion.

➤ For additional information about the VTS installation, see 
"Configuring the VTS Administration Server" on page 37.

➤ Third Parties. Includes the source code for open source packages that are 
incorporated into LoadRunner, and which have licences with source 
distribution clauses.

➤ WinPcap. Installs the WinPcap utility. WinPcap allows the user to capture 
network traffic into a file and analyze it afterwards. WinPcap is used in 
the Server Side Recording feature in the VuGen Web Services protocol. For 
more information about WinPcap, see http://www.winpcap.org/

Determining the Host ID
LoadRunner licences may be either locked or unlocked.

http://www.winpcap.org
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➤ Locked. A locked license can be installed only on the specific computer 
for which the license was issued. You will need to provide the Host ID 
when purchasing a locked LoadRunner license.

➤ Unlocked. Indicates that the license can be installed on any computer. 
You will not need to provide the Host ID when purchasing an 
unlocked LoadRunner license.

To determine a Host ID, perform either of the following procedures on the 
computer for which you require the Host ID:

 1 Click Start > All Programs > HP Software > HP LoadRunner > License > 
LoadRunner License Utility. The HP LoadRunner License Utility opens and 
displays the computer's Host ID.

Or

 1 Run the setup.exe file in the root folder of the LoadRunner installation 
disk.

 2 In the LoadRunner Setup window, click Host ID. The Host ID Generator 
opens.

 3 Click Generate New. The Host ID is displayed.

Installing the Citrix Server Agent
The installation file for the Agent for Citrix Server is located on the 
LoadRunner installation disk, under the Additional Components\Agent for 
Citrix Server folder.

Note that the agent should only be installed on your Citrix server 
machine—not Load Generator machines.

If you are upgrading the agent, make sure to uninstall the previous version 
before installing the next one (see uninstallation instructions below).

To install the Agent for Citrix Server:

 1 If your server requires administrator permissions to install software, log in 
as an administrator to the server.



Chapter 2 • Installing LoadRunner on Windows

36

 2 If you are using a Remote Desktop connection (RDP) to install the agent 
onto a machine running Windows 2003, run the following command on 
the target machine before starting the installation:

 3 Locate the installation file, Setup.exe, on the product installation disk in 
the Additional Components\Agent for Citrix Server\Win32 or ...\Win64 
folder.

 4 Follow the installation wizard to completion.

Note: After installation the agent will only be active for LoadRunner 
invoked Citrix sessions—it will not be active for users who start a Citrix 
session without LoadRunner.

To disable the agent, you must uninstall it.

To uninstall the Agent for Citrix Server:

 1 If your server requires administrator privileges to remove software, log in 
as an administrator to the server.

 2 Open Add/Remove Programs in the server machine’s Control Panel. 
Select HP Software Agent for Citrix Server 32 or 64 and click 
Change/Remove.

Installing the Microsoft Terminal Server Agent
The installation file for the Agent for Microsoft Terminal Server is located on 
the product installation disk, under the Additional Components\Agent for 
Microsoft Terminal Server folder.

Note that the agent should only be installed on your RDP server machine, 
not Load Generator machines.

If you are upgrading the agent, make sure to uninstall the previous version 
before installing the next one (see uninstallation instructions below).

Change user /install
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To install the Agent for Microsoft Terminal Server:

 1 If your server requires administrator permissions to install software, log in 
as an administrator to the server.

 2 If you are using a Remote Desktop connection (RDP) to install the agent 
onto a machine running Windows 2003, run the following command on 
the target machine before starting the installation:

 3 Locate the installation file, Setup.exe, on the LoadRunner DVD in the 
Additional Components\Agent for Microsoft Terminal Server folder.

 4 Follow the installation wizard to completion.

Note: To use the agent, you must set the recording options before 
recording a Vuser script. In the Start Recording dialog box, click Options. 
In the Advanced Code Generation node, check Use RDP Agent.

To uninstall the Agent for Microsoft Terminal Server:

 1 If your server requires administrator privileges to remove software, log in 
as an administrator to the server.

 2 Open Add/Remove Programs in the server machine’s Control Panel. 
Select HP Software Agent for Microsoft Terminal Server and click 
Change/Remove.

Configuring the VTS Administration Server
During the VTS installation process, you need to specify the port that is used 
to access the VTS server for administrative purposes.

To configure the VTS Administration server:

 1 Begin the VTS installation process as described in "Installing Additional 
Components" on page 32.

Change user /install
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During the VTS installation process, the Configure VTS administration 
server screen appears.

 2 In the Admin UI server port box, enter 4000.
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 3 Click Next to continue with the installation. The Configure VTS screen 
appears.

 4 Specify where to save the VTS data file.

 5 Make sure that the Start Virtual Table Server Automatically check box is 
selected.

 6 Click Next, and then follow the wizard’s instruction to complete the VTS 
installation procedure.
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Configuring User Login Settings

By default, you need to manually log on to a computer before LoadRunner 
can run Vusers on that computer. However, you can configure LoadRunner 
to run Vusers on a load generator machine without the need for the Vuser to 
manually log in to the machine.

To configure user login settings:

 1 Select Start > All Programs > HP Software > HP LoadRunner > Tools > 
Agent Runtime Settings Configuration. The LoadRunner Agent Runtime 
Settings dialog box opens.
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 2 Select one of the following options:

➤ Allow virtual users to run on this machine without user login. 
LoadRunner will automatically log on to the network from the load 
generator machine, so the Vusers can run without any manual 
intervention. Enter the network domain where the user machine 
resides, a user name, and password. 

Note: The user specified in the automatic login must have 
administrator privileges on the load generator machine.

➤ Manual log in to this machine. The user must manually log on to the 
network from the load generator machine for each session of running 
Vusers. 

 3 Click OK.

Note: You must boot and log on to the system at least once after the 
LoadRunner installation before the automatic login can work.
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 4 Select Start > All Programs > HP Software > HP LoadRunner > Tools > 
Agent Runtime Settings Configuration. The LoadRunner Agent Runtime 
Settings dialog box opens.

Silent Installation of LoadRunner

A silent installation is an installation that is performed automatically, 
without the need for user interaction.

To perform a silent installation of LoadRunner:

 1 Install the prerequisite software. For the full list of prerequisite software, 
see "Prerequisite Software" on page 17. You can begin the silent 
installation only after all the prerequisite software is installed.

 2 To install all of the LoadRunner components, run one of the following 
commands from the command line:

msiexec.exe /qn /i “<Installation_disk>\lrunner\MSI\LoadRunner_x64.msi” 

msiexec.exe /qn /i “<Installation_disk>\lrunner\MSI\LoadRunner_x86.msi” 



Chapter 2 • Installing LoadRunner on Windows

43

Notes:

➤ Each machine on which you are installing LoadRunner requires 
administration privileges.

➤ LoadRunner MSI supports both 32 bit and 64 bit operating systems. 
Ensure that you run the appropriate MSI version for your operating 
system.

➤ Use Standard MSI command line options to define installation 
properties. For example, use TARGETDIR to specify an alternate 
installation folder.

HP LoadRunner User Interface Pack Installation

The HP LoadRunner User Interface Pack enables you to view the 
LoadRunner, VuGen Standalone, and Analysis Standalone user interface in 
your local language. You install the User Interface Pack from the 
<Language> User Interface Pack CD-ROM. 

 1 Make sure that HP LoadRunner is already installed. For details, see 
"Performing the Installation" at the beginning of this chapter.

 2 Insert the <Language> User Interface Pack CD into the CD-ROM drive. 
The HP LoadRunner <Language> User Interface Pack Setup window 
opens.

Note: If the CD-ROM drive is on a network computer, map the network 
drive, navigate to the root folder of the mapped network path, and 
double-click setup.exe.
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 3 Click the desired link (LoadRunner, Vugen Standalone, or Analysis 
Standalone User Interface Pack Setup) and follow the on-screen 
instructions. 

The <Language> User Interface Pack is automatically installed in the 
location that was specified during the installation of the HP LoadRunner.

Upgrading LoadRunner

Various options exist for upgrading your LoadRunner installation. The 
options vary depending on your installed version of LoadRunner, and the 
version to which you want to upgrade. 

Upgrading to LoadRunner 11.50

➤ If your installed version of LoadRunner is prior to version 11.00, uninstall 
LoadRunner and then install LoadRunner 11.50. For details, see 
"Performing the Installation" on page 20.

➤ If you have LoadRunner 11.00 installed, install LoadRunner 11.50 as 
described in "Performing the Installation" on page 20.

Upgrading to LoadRunner Service Pack 11.51
You must have LoadRunner 11.50 installed before you can install 
LoadRunner Service Pack 11.51. To install LoadRunner Service Pack 11.51, 
run the LoadRunner Service Pack 11.51 installation wizard, and then follow 
the online instructions.
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3
Installing the HP Load Generator on 
Linux

You can install the HP Load Generator component on a Linux platform to 
run Vusers. The Linux Vusers interact with the Controller, installed on a 
Windows machine. 

This chapter describes how to install the load generator on a Linux machine.

This chapter includes:

➤ Understanding the Installation Process on page 46

➤ Linux System Requirements on page 47

➤ Installing Using the Setup Wizard on page 48

➤ Using Native Package Commands on page 51

➤ Silent Installation on page 52

➤ After Installing the HP Load Generator on Linux on page 53

➤ Uninstalling the HP Load Generator on page 59

➤ Recommended Configuration on page 60
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Understanding the Installation Process

The HP Load Generator Linux installation involves the following steps:

 1 Review system requirements

Before you install the HP Load Generator on Linux, review the system 
requirements as described in "Linux System Requirements" on page 47.

 2 Install the HP Load Generator

You install HP Load Generator using the HP Load Generator Setup 
wizard. For more information, see "Installing Using the Setup Wizard" on 
page 48.

Advanced users can install the The HP Load Generator native package 
directly using Native package commands. For example, if you are using a 
remote deployment tool to install the HP Load Generator on multiple 
machines, you may need to use native package commands. For more 
information, see "Using Native Package Commands" on page 51.

 3 Configure your environment

Before you can begin working with the load generator you need to 
configure your environment. This involves setting the appropriate 
environment variables, checking access to the load generator, and 
verifying the installation. See "After Installing the HP Load Generator on 
Linux" on page 53.

Notes and Limitations

➤ The HP Load Generator installation is based on native packages per 
operating system. This requires you to be logged in as root user to run the 
installation. 
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Linux System Requirements

This section describes the system requirements necessary for installing the 
HP Load Generator on a Linux machine.

The following table describes the supported operating systems on which you 
can install a Linux Load Generator. 

Note: The HP Load Generator supports all X Servers. 

Memory (RAM)

256 MB minimum

Note: Memory depends on protocol type and 
system under test and can vary greatly.

Available Hard Disk Space 500 MB minimum

OS Type OS Version Platform

Red Hat 
Linux

➤ Enterprise Linux 5.0

➤ Enterprise Linux 6.0

➤ CPU Type: Intel Core, 
Pentium, AMD or 
compatible

➤ Speed: 1 GHz minimum. 2 
GHz or higher 
recommended
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Installing Using the Setup Wizard

This section describes how to install the HP Load Generator on Linux using 
the setup wizard. 

 1 Ensure that you are logged in as root user.

 2 Launch the setup wizard.

Run the following command to launch the setup wizard:

The setup wizard welcome screen opens. 

Select Next to continue.

<LoadGenerator Linux installation disk>/Linux/installer.sh 
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 3 Review the License agreement. 

To view the entire license agreement, select View Agreement.

If the terms of the license agreement are acceptable to you, select Agree to 
continue.

 4 Select the installation directory.

Select Different Directory to install the load generator in a different 
directory, or select Next to install the load generator in the 
/opt/HP/HP_LoadGenerator directory.



Chapter 3 • Installing the HP Load Generator on Linux

50

 5 Start the installation process.

The wizard prompts you to confirm the installation. 

Select Install to start the installation process. 

The Installation screen opens, displaying the progress of the installation. 
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 6 Complete the installation.

When the installation is complete, the Finish screen opens. 

➤ Select View Log to view a log of the installation process.

➤ Select Finish to complete the installation.

 7 Configure your environment

After you install the load generator, configure your environment as 
described in "After Installing the HP Load Generator on Linux" on 
page 53.

Using Native Package Commands

You can run the HP Load Generator installation using native package 
commands. The native package name for the HP Load Generator is 
LoadGenerator. 

There is a separate native package for each OS platform located at: <HP Load 
Generator Linux installation disk>/Linux/packages/
packages_Linux/LoadGenerator-11.50.000-Linux2.6.rpm. 

Note: This section contains general reference information about native 
package commands. For detailed information about the native package 
commands, refer to your relevant operating system documentation.
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 1 Run the relevant installation command described in "Native Package 
Commands Table" on page 52.

 2 Run the run_after_install.sh script located in the 
/opt/HP/HP_LoadGenerator directory.

Native Package Commands Table
The following table describes the relevant installation commands for Linux:

Silent Installation

To perform a silent installation of the HP Load Generator, perform the 
following procedure:

 1 Run the relevant installation command as described below:

 2 Run the run_after_install.sh script located in the 
/opt/HP/HP_LoadGenerator directory. 

Install Command
Get Package 
Information 
Command

Uninstall 
Command

rpm --nodeps -i --nomd5 <path 
to rpm file>

For example: 
rpm --nodeps -i --nomd5 
/dev/cdrom/Linux/packages/pac
kages_Linux/LoadGenerator-
11.50.000-Linux2.6.rpm

rpm –q 
LoadGenerator

rpm -e 
LoadGenerator

Silent Installation Command Example

rpm --nodeps -i --nomd5 
<path to rpm file>

rpm --nodeps -i --nomd5 
/dev/cdrom/Linux/packages/pac
kages_Linux/LoadGenerator-
11.50.000-Linux2.6.rpm
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Creating Symbolic Links
This section describes how to create a symbolic link.

Assume for example that the installation directory is 
/opt/HP/HP_LoadGenerator and that you want to store the load generator 
content in /usr/HP/HP_LoadGenerator.

 1 Create the new directory. For example:

 2 Make sure that the directory /opt/HP exists. If it does not exist, create the 
directory as follows:

 3 Create a symbolic link from /opt/HP/HP_LoadGenerator to the other 
directory. For example:

In the above example, the symbolic link called HP_LoadGenerator in the 
directory /opt/HP points to the directory /usr/HP/HP_LoadGenerator.

After Installing the HP Load Generator on Linux

This section describes the configuration steps you need to complete before 
you can begin working with the HP Load Generator on Linux. 

To complete the setup process after installing the load generator, you must:

 1 Set the appropriate environment variables. 

See "Setting Environment Variables" on page 54.

 2 Verify your Linux installation. 

See "Verifying the Linux Installation" on page 55.

 3 Check that the Controller can access the load generator. 

mkdir –p /usr/HP/HP_LoadGenerator

mkdir –p /opt/HP

ln -s /usr/HP/HP_LoadGenerator 
/opt/HP/HP_LoadGenerator
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See "Checking Controller Connection" on page 57.

Setting Environment Variables
To work with the load generator, your Linux startup configuration file needs 
to include specific environment variables. At the end of the load generator 
installation, the installer creates the env.csh script. For C Shell users, this 
script is used to set the appropriate environment variables. (See "Setting 
Environment Variables For C Shell Users" below).

Bourne and Korn shell users need to set the variables manually. (See "Setting 
Environment Variables For Bourne and Korn Shell Users" on page 55.)

The following environment variables need to be included:

➤ M_LROOT. The location of the Linux Load Generator installation 
directory

➤ PATH. The location of the Linux Load Generator bin directory.

➤ LD_LIBRARY_PATH. The location of Linux Load Generator’s dynamic 
libraries. 

If you are running Vusers for a protocol that requires a client installation 
(for example, Oracle), make sure that the path for the client libraries is 
included in the dynamic library path environment variable 
(LD_LIBRARY_PATH or SHLIB_PATH).

To check the dynamic libraries used by your application, type:.

Setting Environment Variables For C Shell Users

At the end of the load generator installation, the installer creates the env.csh 
script. This script is used to set the appropriate environment variables.

To set the environment variables, users need to add the env.csh script to 
their .cshrc startup configuration file. 

Add the following line in the .cshrc startup configuration file:

ldd application_name

source <load generator installation directory>/env.csh
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For example:

Setting Environment Variables For Bourne and Korn Shell Users

Bourne and Korn shell users need to set the environment variables manually 
in the .profile startup configuration file. Use the following example to set up 
your environment variables:

Verifying the Linux Installation
The installation includes a setup verification utility, verify_generator, that 
checks the load generator setup on your Linux machine. It checks 
environment variables and your .cshrc or .profile file to verify that they are 
set up correctly. 

It is strongly recommended that you run verify_generator after an 
HP Load Generator installation, before attempting to invoke the 
application. 

The verify_generator utility checks the following items: 

➤ There are at least 128 file descriptors

➤ The .rhost permissions have been defined properly: -rw-r--r--

➤ The host can be contacted by using rsh to the host. If not, it checks for 
the host name in .rhosts

➤ M_LROOT is defined

➤ .cshrc or .profile defines the correct M_LROOT

source /opt/HP/HP_LoadGenerator/env.csh

# LoadRunner settings #
#Chooses a path based on the location of the machine dependent LR installation #

M_LROOT={replace w/ LR Linux installation path} ; export M_LROOT
LD_LIBRARY_PATH=${M_LROOT}/bin; export LD_LIBRARY_PATH

PATH=${M_LROOT}/bin:${PATH}; export PATH

# End LoadRunner setting #
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➤ .cshrc or .profile exists in the home directory

➤ The current user is the owner of the .cshrc or .profile

➤ A Linux Load Generator installation exists in $M_LROOT

➤ The executables have executable permissions

➤ PATH contains $M_LROOT/bin, and /usr/bin

➤ The rstatd daemon exists and is running

Running verify_generator

Before you run the verify_generator utility, make sure that you have set the 
DISPLAY environment variable on your machine.

 1 From the <load generator installation directory>/bin, run the following 
command:

for example:

If you want to receive detailed information about the checks you can use 
the -v option, as follows:

 2 View the results.

➤ If the settings are correct, verify_generator returns OK. 

➤ If they are incorrect, verify_generator returns Failed and a suggestion 
on how to correct the setup.

verify_generator

/opt/HP/HP_LoadGenerator/bin/verify_generator

verify_generator -v
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Checking Controller Connection
By default, the Controller connects remotely to the load generator using rsh 
(remote shell). You need to make sure that the load generator can be 
remotely accessed by the Controller.

 1 On the load generator machine, go to the .rhosts file, located in the user 
home directory.

 2 In the .rhosts file, verify that the Controller is included in the list of 
machines. If it is not listed, add it to the list.

If the Controller still cannot connect to the load generator, contact your 
system administrator.

Note: You can configure the Controller to connect to the load generator not 
using rsh. In this case, you need to activate the agent daemon on the load 
generator. For more information, see the "Connecting to a Linux Load 
Generator Without Using RSH" below.

Connecting to a Linux Load Generator Without Using RSH

This section describes how to connect to a Linux load generator without 
using RSH.

 1 On the Linux load generator, run the agent daemon by running the 
following command from <load generator installation directory>/bin:

This runs a daemon called m_agent_daemon, and if successful you will 
receive a message: m_agent_daemon <process ID>.

The agent will now keep running, even if the user is logged off. It will 
only stop running using the command explained in step 9 below, or by 
rebooting the machine.

m_daemon_setup -install
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Note: If you look at the log file m_agent_daemon[xxx].log in the temp 
directory, you may see communication errors, even if the installation 
succeeded.

 2 In the Controller, select Scenario > Load Generators. The Load 
Generators dialog box opens. 

 3 Click Add. The Load Generators dialog box opens. 

 4 In the Name box, enter the name of the computer on which the load 
generator is running.

 5 From the Platform list, select UNIX. 
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 6 Click More.

 7 Click the UNIX Environment tab, and select the Don’t use RSH option.

 8 Connect as usual.

 9 To stop the agent daemon, run the following command from the 
<LR_root>/bin directory: 

This stops the m_agent_daemon, and if successful, you will receive a 
message: m_agent_daemon is down.

Uninstalling the HP Load Generator

You can use the Maintenance wizard to uninstall the HP Load Generator. 

Note: You can also uninstall the HP Load Generator using the commands as 
described in "Using Native Package Commands" on page 51. 

 1 Make sure that you are logged in as root user.

 2 Make sure that the load generator is not connected to any Controller 
machine.

 3 Make sure that the m_agent_daemon process is not running on your 
machine.

 4 Launch the maintenance wizard by running the following command:

 5 Follow the remaining instructions in the wizard to uninstall the HP Load 
Generator.

m_daemon_setup -remove

/var/opt/HP/iHP/HP_LoadGenerator/11.50.000/installer.sh
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Recommended Configuration

You can increase the number of file descriptors, process entries, and amount 
of swap space by configuring the kernel, as described in this chapter.

Note: Most operating systems using the Linux Load Generator have 
sufficient default file descriptors, process entries, and swap space, and rarely 
require reconfiguration.

This section includes recommendations for improving load generator 
performance. This section includes:

➤ "Increasing Process Entries" on page 60

➤ "Increasing File Descriptors" on page 60

➤ "Increasing Swap Space" on page 62

Increasing Process Entries 
Each Vuser requires several free process entries. To increase the number of 
process entries on your system, you must reconfigure the kernel. 

Linux

This section describes how to reconfigure the kernel for Linux platforms.

 1 Locate the /etc/security/limits.conf file.

 2 Set the maximum number of processes in the limits file. Type:

 3 Reboot the machine.

Increasing File Descriptors
A load generator uses the following File Descriptor resources:

➤ 14 file descriptors for the launch service

hard nproc 8192
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➤ 20 file descriptors for the agent

➤ 30 file descriptors for each Vuser driver. By default, there is a driver for 
every 50 Vusers.

➤ File descriptors for the running Vusers. Each Vuser requires 2 descriptors.

For example, to compute the number of file descriptors used in running 100 
threaded Vusers, the load generator requires:

Total: 294 File Descriptors

If Vusers are run as processes instead of threads, one driver is run per Vuser. 
Therefore, each Vuser requires 30 file descriptors.

The procedure to increase the number of file descriptors differs between 
platforms and shells. 

All Platforms

In these examples, the number of descriptors is increased to the maximum 
of 1024.

➤ For sh and ksh users, type:

➤ For csh users type:

Descriptors Purpose of the descriptors

14 for the launcher

20 for the agent

60 for 2 drivers (30 x 2, each one drives 50 Vusers)

200 for 100 Vusers (each Vuser requires 2)

ulimit -n 1024

limit descriptors 1024
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Linux

This section describes some alternate procedures to increase file descriptors 
on Linux operating systems. In these examples, the number of descriptors is 
increased to the maximum of 8192. 

 1 Add the following line to the /etc/security/limits.conf file:

 2 Add the following line to the /etc/sysctl.comf file:

 3 Reboot the machine.

Increasing Swap Space
Each Vuser requires swap space ranging from 200 KB to 4 MB. Before adding 
space to your system configuration, you should determine your paging 
requirements. For environments running programs with very large memory 
requirements, it is recommended to have paging space of four times the 
physical memory. If you do not have enough paging space, certain processes 
may be killed, and others will be unable to start.

hard nfile 8192

fs.file-max = 8192
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4
Viewing and Modifying a License

During the LoadRunner installation, if LoadRunner does not detect a valid 
LoadRunner license on your computer, you are automatically issued with a 
temporary 10-day license for 25 Vusers. To use LoadRunner beyond the 10-
day period, you must request and enter additional license information for 
your LoadRunner installation. 

To run Vusers from the LoadRunner Controller, you need the appropriate 
LoadRunner licenses. These licenses must be installed on the computer on 
which the LoadRunner Controller is installed. You use the LoadRunner 
License Utility to manage your LoadRunner licenses. The LoadRunner 
License Utility enables you to:

➤ View the details of licenses that are currently installed.

➤ Install additional licenses.

This chapter describes how to use the HP LoadRunner License Utility to 
view, enter, and modify license information. 

This chapter includes:

➤ Installing a New License on page 64

➤ Viewing License Information on page 66

➤ Troubleshooting Licenses on page 70
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Installing a New License

After you receive your license information from your HP representative, you 
can use the HP LoadRunner License Utility to enter the license information.

Using the LoadRunner License Utility, you can install a new license by using 
either a license file or a license key.

➤ License file. When you purchase a new license, HP may send you an email 
with an attached license file. The license file contains the license keys for 
one or more licenses. When you use the license file to install the new 
licenses, the LoadRunner License Utility reads the license file and extracts 
all the license keys that are included in the license file. You can then 
select which of the available licenses to install. You may choose to use a 
license file to install LoadRunner licenses because the license file enables 
you to install multiple licenses simultaneously.

➤ License key. Unlike a license file, a license key enables you to install just a 
single license at a time. You may receive the license key directly from HP, 
or the license key may be included in a license file that you receive from 
HP.

To install a new LoadRunner license:

 1 click Start > All Programs > HP Software > HP LoadRunner > License > 
LoadRunner License Utility. The HP LoadRunner License Utility opens.

 2 In the LoadRunner License Utility, click Install New Licenses. The 
LoadRunner License Utility - New License dialog box opens.

To install using a license file

 3 Click the Browse button to the right of License file, and locate the license 
file that was sent to you by HP.

 4 Click View License File Content to display details of the licenses that are 
included in the license file.

 5 In the list of licenses included in the license file, select the licenses to 
install.

To install using a license key

 6 Click Install a license using a license key.

 7 Enter the license key that you received from HP.
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To complete the installation

 8 Click Install. The selected licenses are installed.

 9 Click Close. In the License Summary table, make sure that the new 
licenses appear in the list of installed licenses.
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Viewing License Information

You can view your license information from the HP LoadRunner License 
Utility.

To view your license information, click Start > All Programs > HP Software > 
HP LoadRunner > License > LoadRunner License Utility. The HP LoadRunner 
License Utility opens. 
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The HP LoadRunner License Utility displays the following information:

➤ Host ID. Identifies the computer on which the Controller is installed. You 
may need to provide the Host ID when purchasing new LoadRunner 
licenses. To obtain new LoadRunner licenses, click the Contact HP to 
purchase a new license link at the bottom of the LoadRunner License 
Utility.

➤ License Summary. Displays a list of the LoadRunner licenses that are 
installed on the Controller computer. Click on any license in the table to 
display additional details about the license. The Vuser protocols included 
in the selected license box displays a list of the Vuser protocols that are 
included in the selected license.

➤ Status. Indicates the status of the license. 

➤ Valid. Indicates that the license in current and functional. 

➤ Invalid. Indicates that the license is no longer valid. An Evaluation 
license or an Instant on license becomes invalid if a Time limited, 
Permanent, or VUD license is installed for the same Vuser bundle. A 
VUD license becomes invalid when the remaining capacity is zero. By 
default, the License Summary table does not show invalid licenses. 
Select the Include invalid licenses check box to show invalid licenses. 
Note that a license may become temporarily invalid if the LoadRunner 
License Utility detects that the system clock has been tampered with. 
To restore the affected licenses, reset the system clock to the current 
time.

➤ To be Expired. Indicates that the license will expire within 30 days. 

➤ Locked. 

➤ Locked. Indicates that the license can be installed only on the 
computer on which it is currently installed – not on any other 
computer.

➤ Unlocked. Indicates that the license can be installed on any computer.
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➤ License Bundle. Indicates the name of the Vuser protocol bundle to which 
the license applies. The license enables the Controller to run Vusers of any 
protocol that is included in the protocol bundle. To display a list of the 
Vuser protocols that are included in a bundle, click the license in the 
License Summary table. A list of the associated Vuser protocols is 
displayed at the bottom of the LoadRunner License Utility.

Note that a Partner License icon that appears to the left of a license 
bundle indicates that the license is for a LoadRunner partner, and not for 
standard LoadRunner Vuser protocols. Partner licenses enable third-party 
applications to be controller by the LoadRunner Controller. Partner 
licenses operate the same as standard LoadRunner licenses.

➤ Type. Indicates the type of license:

➤ Instant On licenses are installed when LoadRunner is first installed. 
Note that the expiration date of an Instant On license is calculated 
based on the date on which LoadRunner is first installed. You cannot 
extend the Expiration Date of an Instant On license by uninstalling 
and then reinstalling LoadRunner.

➤ Evaluation licenses are supplied to enable potential customers to 
evaluate LoadRunner functionality. 

➤ Time limited licenses are valid for a limited period only. Time limited 
licenses are typically issued for 60 or 365 days. 

➤ Permanent licenses do not expire -  there is no time limit to the 
validity of these licenses. 

➤ VUD licenses are issued with a limited capacity. The capacity is defined 
by the measurement Vuser-days or VUDs. For example, the capacity of 
a VUD license may be 1000  VUDs. Each day that the Controller is 
used to run Vusers, the maximum number of Vusers that ran 
simultaneously on that day is deducted from the remaining license 
capacity. If a maximum of 200 Vusers ran on day 1, then 800 VUDs 
will remain in the license. 
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For example, assume that you purchase a license for 100 VUDs, and 
then run 3 different scenarios within the same 24 hour period, with 20 
Vusers in each scenario. At the end of that period, only 20 VUDs (and 
not 60) are deducted from your total number of available VUDs, 
leaving you with 80 remaining VUDs which can be used at any time in 
the future.

➤ Expiration Date. Indicates the date and time when Time limited, Instant 
on, and Evaluation licenses expire.

➤ Capacity. Indicates the capacity of the selected license:

➤ For Instant on, Evaluation, Time Limited, and Permanent licenses, 
Capacity indicates the maximum number of Vusers [of the type 
specified by the license bundle] that can be run simultaneously from 
the LoadRunner Controller. 

➤ For VUD licenses, Capacity indicates the number of VUDs that remain 
in the license.

➤ Show invalid licenses. Select this check box to show invalid licenses in the 
list of LoadRunner licenses that are installed.

➤ Vuser protocols included in the selected license. Displays the Vuser 
protocols that are included in the selected license.

➤ Install New Licenses. Opens the New License dialog box which enables 
you to install new LoadRunner licenses. 

Generating a Host ID

LoadRunner requires the appropriate licences to run Vusers from the 
Controller. The licences may be either locked or unlocked.

➤ Locked. Indicates that the license can be installed only on the 
computer on which it is currently installed – not on any other 
computer.

➤ Unlocked. Indicates that the license can be installed on any computer.

For details on how to determine the Host ID for your computer, see 
Determining the Host ID on page 34.
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Troubleshooting Licenses

If you have a temporary license, contact HP Customer Support to obtain a 
permanent license.

If LoadRunner does not accept your license key, perform the following 
checks:

➤ Make sure you typed in the license key exactly as it was given to you. The 
license key must include the required spaces. The license key is case 
sensitive.

➤ If you receive a permission denied error message during Controller start-
up, you must grant Full Control permission for the Registry's 
HKEY_LOCAL_MACHINE key and in the WINNT folder (the folder where 
Windows is installed), as described below.

To add Registry permissions: 

 1 Run regedt32 to modify the registry.

 2 Select the HKEY_LOCAL_MACHINE key.

 3 Select Security > Permissions.

 4 Add Full Control permission to the user that is running the Controller.

 5 Turn on the Replace Permission on the Existing Subkeys flag.

 6 Click OK.

To add permissions on an NTFS file system:

 1 Select the <System Drive>:\WinNT folder.

 2 Invoke Properties.

 3 Select the Security tab.

 4 Click Permissions.

 5 Add Full Control permission for the user.

 6 Turn on the Replace Permissions on Subdirectories flag.

 7 Click OK.
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